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Configuring and using e-mail notification 

This module will cover configuring and using e-mail notification in IBM Rational ClearQuest 
versions 7.0 or higher 
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Module objectives 

� The following topics are covered in this module: 
�System requirements 

�Used technologies 

�Enabling e-mail notification in ClearQuest and 
ClearQuest Web 

�Configuring e-mail rules 

�When you complete this module, you will be able 
to: 

�Set up ClearQuest to send out notifications by e-mail 
upon modification of records in your database 

The following topics are covered in this module: the system requirements for using e-mail 
notification in ClearQuest and the underlying technologies used, enabling e-mail 
notifications in ClearQuest and ClearQuest Web, and how to configure e-mail rules to 
adapt e-mail notification to your business requirements. 

Upon completion of this module, you will be able to set up ClearQuest to send out 
notifications by e-mail upon modification of records in your database. 
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System requirements 

� SMTP server or Exchange server with MAPI protocol 
�ClearQuest sends e-mail through such a server 
�There is no authentication or SSL support at this time 
�MAPI is only available on Windows® 

In order to make use of ClearQuest’s e-mail notification feature, you need to have an e-
mail server available. ClearQuest supports the Simple Mail Transfer Protocol (SMTP), or 
the Mail Application Programming Interface (MAPI) in combination with a Microsoft® 

Exchange server. Please note that as of the time of writing, there is no support for secure 
SMTP connections over SSL or SMTP authentication. Also, keep in mind that since MAPI 
is a proprietary implementation by Microsoft, it is only available on Windows. Therefore, if 
you have ClearQuest clients running in UNIX or Linux operating systems, you will only be 
able to use an SMTP server for sending e-mail. 
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Underlying technologies: SMTP 

�SMTP: Simple Mail Transfer Protocol 
�Used for mail transfer between e-mail servers and from 

clients to e-mail servers 

�Uses TCP port 25 

�Provides various access control mechanisms (Relay 
Control) 

The SMTP is one of the technologies involved in using e-mail notification in ClearQuest. 
SMTP is used for mail transfer between e-mail servers and for the submission of e-mail 
from a client to an e-mail server. SMTP runs on TCP port 25 and provides a number of 
mechanisms to prevent unauthorized access to e-mail servers to keep them from being 
used for spam. 
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Underlying technologies: MAPI 

�MAPI: Mail Application Programming Interface 
�Proprietary implementation by Microsoft 

�Uses Microsoft Exchange 

�Uses TCP port 135 and other dynamically assigned ports 

ClearQuest can use the MAPI, which is a proprietary implementation by Microsoft. It uses 
a Microsoft Exchange server. MAPI uses TCP port 135 and other dynamically assigned 
ports. 
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Preparing ClearQuest for e-mail notification 

�Check if e-mail package is installed in your schema 

“Email” 
package 

is 
installed 

Highlight 
your 

schema 

The “Email” package needs to be installed in your schema to use the e-mail notification 
function of ClearQuest. To determine whether you have the package installed, open your 
Schema Repository in the ClearQuest Designer and select “Schema Summary” from the 
“View” menu. On the left, highlight your schema. On the right, you will see a list of 
associated packages. If the “Email” package appears in that list, it is installed in your 
schema. 

Note that the version you see in the window may differ from the version you see in this 
screen capture. If you do not see the package in this list, you will need to install the 
package yourself, which is described in the next step. 
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Preparing ClearQuest for e-mail notification 

� Install the “Email” package in the schema 

Select 
“Email” 

package 

If the “Email” package is not installed in your schema, you can install it yourself from the 
ClearQuest Designer. From the “Package” menu, choose “Package Wizard”. In the 
following window (shown here), choose the “Email” package and click “Next”. Note that the 
version that you will see may differ from the one in this screen capture. 
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Preparing ClearQuest for e-mail notification 

�Select a schema 

Select the 
schema to 
install the 

package in 

Next, you will be required to select the schema that you want to install the “Email” package 
in. All schemas that already have the package installed will be hidden. Highlight the 
schema you want to enable e-mail notification for and click “Next”. 
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Preparing ClearQuest for e-mail notification 

�Enable a Record Type 

Select all 
Record Types 

that e-mail 
notification 
should be 
enabled 

The final step will allow you to select all Record Types that you would like to enable e-mail 
notification for. You will only be able to configure ClearQuest to send e-mail notification for 
changes made to records that you have selected here. If you do not want to enable all 
record types at this stage, you can enable additional Record Types at a later time. When 
complete, click “Finish”. 

The ClearQuest Designer will automatically check out your schema, and you will see an 
additional stateless Record Type called “Email_Rule.” Check your schema, and upgrade 
all user databases to finalize the preparation of ClearQuest for e-mail notification. 

RCQ_ClearQuest_EmailNotification.ppt Page 9 of 32 



  

   -    

     

  

       
      

          
 

              
               

            
              

    

10 

Configuring and using e mail notification © 2008 IBM Corporation 

IBM Software Group | Rational software 

Configuring e-mail rules 

�E-Mail rules determine who receives an e-mail 
when specific actions are performed on records 

� To edit e-mail rules, a user needs to have Schema 
Designer privileges 

Now that you have completed the preparation of ClearQuest for e-mail notification, you will 
need to configure e-mail rules, which determine who will be notified by e-mail once a 
specific action has been performed on record. E-mail rules are realized through 
“Email_Rule.” In order to create or modify e-mail rules, a ClearQuest user needs to have 
at least Schema Designer privileges. 
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Configuring e-mail rules 

Enter a 
descriptive 

name 

Choose a 
record type 

Check to 
activate rule 

Choose 
fields to 

monitor for 
changes 

To create a new e-mail rule, open your ClearQuest Database and select the “Email_Rule” 
record type from the drop down. This will display a form like the one in the screenshot. On 
the first tab you specify some general properties of the new e-mail rule, such as the name 
and the record type that this e-mail rule should apply for. Choose a record type. 

You can also choose from the list of all fields belonging to the record type that you wish to 
monitor for changes. In addition, you can specify a filter query which is used to limit the list 
of records that this e-mail rule will be applied to. Check the box labeled “Active Rule.” 
Finally, choose an operator to logically link the conditions you define. 
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Configuring e-mail rules 

Choose one 
or more 

action types 

Choose one 
or more 

destination 
states 

Choose one 
or more 
source 
states 

Choose one 
or more 
actions 

On the second tab, “Action Controls,” you can configure the actions or states that this e-
mail rule should apply for. You can select either “Actions” or “Action Types.” Alternatively, 
you can specify one or more source or destination states. With this, you can configure 
ClearQuest to only send an e-mail when a record moves into the “Closed” state and not on 
any other state. 
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Configuring e-mail rules 

Enter the 
sender of 
the e-mail 

Choose fields that 
should be 

displayed in the 
subject of the 

notification e-mail 

Choose fields to be 
displayed in the 

body of the e-mail 

On the third tab, “Display Fields,” you can configure what the e-mail will look like and what 
information it contains. 

In the line “From Address,” you can enter an e-mail address that will be used as the 
sender of the notification e-mails. You can also enter “Current User,” which causes 
ClearQuest to automatically insert the e-mail address of the user that is triggering the e-
mail notification. 

You can choose the fields that should be displayed in the subject of the e-mails. Do not 
include too many fields here, as the subjects may get too long. 

You can also choose the fields that should be displayed in the body of the e-mail. If you 
check the “Include Entire Defect” box, all fields of the record type will be displayed in the 
body of the e-mail. If you check the “Show Previous Values” box, the e-mail will include 
both the current field value and the value before. 
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Configuring e-mail rules 

User 
“engineer” 

will be 
notified 

The 
current 

owner will 
be notified 

Now that you have configured when ClearQuest sends an e-mail notification and what 
information this e-mail should contain, all you need to configure is who should be receiving 
these notifications. This is done on the “To Addressing Info” and “CC Addressing Info” 
tabs. In the field labeled “To Users”, you can select from all users in the ClearQuest user 
database who should be notified. The field labeled “To Groups” allows you to pick one or 
more groups whose members will be notified. In the field “To Addresses (Fields),” you can 
select a field that contains either a ClearQuest username or an e-mail address. If the field 
that you select here contains a ClearQuest username, ClearQuest will retrieve the e-mail 
address of that user. Finally, in the field “To Addresses (text)” you can enter one or more 
e-mail addresses that the notifications will be sent to. 

In the scenario depicted in the screenshot, a notification will be sent to the user “engineer” 
and to the user who is the current owner of a record. This concludes the configuration of 
e-mail rules. You can now configure your ClearQuest clients. 
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Configuring the local ClearQuest clients 

�Configuration needs to be done on all clients for all 
users individually 

�Use of MAPI requires that Microsoft Outlook® be 
installed locally 

�Use of MAPI also requires that Collaboration Data 
Objects be installed not newer than version 
5.0.2448.0 or 5.5.2448.0 (Outlook 2002 Service 
Pack 1) 

�Create a MAPI profile on the current machine 

Before you configure your ClearQuest client to send e-mail notification, you should take a 
few things into consideration. 

Since ClearQuest does not send e-mails from a central point but rather from the client on 
a user’s workstation, you need to configure the client on all workstations individually for all 
users. 

If you wish to use MAPI as your e-mail provider, you need to have Microsoft Outlook 
installed on the same machine as ClearQuest. You also need to install the Collaboration 
Data Objects (CDO) that come as an optional install as part of the Microsoft Excel 
installation. 

Finally, the latest versions of the CDO that will work with ClearQuest are the ones that 
came with Microsoft Outlook 2002 Service Pack 1. Please keep in mind that MAPI is only 
available on Microsoft Windows operating systems and not on UNIX or Linux platforms. 
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Configuring the local ClearQuest clients 

Choose 
whether to use 
SMTP or MAPI 

While the screenshots for the following steps show the configuration of e-mail notification 
in the ClearQuest client, the steps are almost the same for the configuration of the 
Eclipse-based ClearQuest RCP client and Eclipse with the ClearQuest plug-in. Where 
differences exist, they are pointed out. 

To start the configuration of the ClearQuest client, log in to a user database of your choice 
and choose “E-mail options” from the “View” menu in the ClearQuest client. In the RCP 
client, select “E-mail options” from the “Tools” menu. 

Select the e-mail provider you wish to use, either SMTP or MAPI. Make sure you check 
the “Enable E-mail notification” box. Click “Next.” 
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Configuring the local ClearQuest clients 

� For SMTP: Enter the host 
name or IP 

address of the 
SMTP server 

Enter your 
e-mail address 
to be used as 

the sender 

If you chose SMTP as your e-mail provider, you will be prompted to provide both the host 
name or IP address of the SMTP server that you would like to send e-mail notification 
through, as well as your e-mail address. This address will appear as the sender of all e-
mail notification triggered by the current (Windows) user on this workstation. Click “Finish.” 
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Configuring the local ClearQuest clients 

� For MAPI: Choose the 
MAPI profile 

you have 
configured on 
your machine 

If you chose MAPI as your e-mail provider, you need to select your locally created MAPI 
profile from the dropdown list. In the RCP client, you will be presented with a text input 
field where you need to enter the name of the MAPI profile that should be used. Click 
“Finish.” 

This concludes the configuration of e-mail notification for ClearQuest. If you are using 
ClearQuest Web instead of or in addition to locally installed clients, you need to make 
additional changes, which will be discussed on the following slides. 
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E-mail notification in ClearQuest Web 

� For SMTP: 

Select 
SMTP 

Enter the 
host name 

or IP 
address of 
the SMTP 

server 

If you are using ClearQuest Web and want to have your users notified about changes to 
records, you need to enable e-mail notification. This needs to be done once by a 
ClearQuest user who has Super User privileges (usually the “admin” user). All ClearQuest 
users accessing ClearQuest Web will then have e-mail notification turned on. 

To enable e-mail notification, log in to ClearQuest Web and click the “Site Configuration” 
link at the top of the page. Select the “Email Options” tab to display the settings for e-mail 
notification. From the drop-down list “Sending Email Status,” select “Active,” choose 
“SMTP” as the Mail Transport Type and Fill in the host name or IP address of the SMTP 
server that you would like to use in the field labeled “SMTP Host”. The e-mail address you 
enter in the field “SMTP Reply To” will be used as the sender of all e-mail notifications, 
unless the user that triggers a notification (occuring when the user modifies a record) has 
an e-mail address configured in their ClearQuest user profile. In that case, the value in the 
field “SMTP Web Server Real Name” will also be displayed as the real name of the sender 
of the notification. 
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E-mail notification in ClearQuest Web 

� For MAPI: 
�1. Join the machine with ClearQuest Web to the domain 

�2. Change the Log On settings of the IBM Rational 
ClearQuest Registry Server Service to the Exchange 
domain user 

�3. Make the domain user a member of the local Power 
Users or Administrators group 

Using MAPI for e-mail notification in ClearQuest Web requires several changes to the 
configuration of ClearQuest and Windows. 

First, join the machine where ClearQuest Web is installed to the domain the exchange 
server is on. 

Then, go to the “Services” panel in the “Administrative Tools” section of the Windows 
Control Panel. Right-click “IBM Rational ClearQuest Registry Server” and select 
“Properties”. Switch to the tab labeled “Log On” and select “This account” under the “Log 
on as:” heading. Enter the login information for the domain user whose Exchange mailbox 
you will be using and click OK. 

Next, make the same domain user a member of the local “Power Users” or 
“Administrators” group. 
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E-mail notification in ClearQuest Web 

�4. Create a MAPI profile 

�5. Restart the IBM Rational ClearQuest Registry Server 
service 

�6. Configure ClearQuest Web through Site Configuration 

Select 
MAPI 

Enter the 
Mailbox 

Alias 

Enter the 
host name 

or IP 
address of 

the 
Exchange 

server 

Log in to the machine where ClearQuest Web is installed as the domain user whose 
Exchange account you are using. Create a MAPI profile using the “Mail” pane in the 
Windows Control Panel. Open Microsoft Outlook to verify configuration was successful. 

Next, log back in to the machine as an Administrator and restart the IBM Rational 
ClearQuest Registry Server service. 

Finally, log in to ClearQuest as a user with Super User privileges and select “Site 
Configuration” from the top nagivation menu. Select the “Email Options” tab. Select 
“Active” from the “Sending Email Status” dropdown, and choose “MAPI” as the Transport 
Type. In the MAPI Mail Server field, enter the host name or IP address of the Exchange 
server, and, in the field labeled “MAPI Mailbox Alias,” enter the alias of MAPI mailbox as 
defined when you created the Exchange account. 

Click “Save.” This concludes the configuration steps for Email Notification with MAPI for 
ClearQuest Web. 
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Configuring e-mail notification on Linux ® and UNIX® 

� 1. Configuring the RCP Client 

� 2. Configuring ClearQuest Web 

This section of the module describes the steps required to configure ClearQuest and 
ClearQuest Web on Linux or UNIX operating systems to use e-mail notification. 

On Linux and UNIX operating systems only SMTP is available as a mail transport provider. 

The configuration of the RCP client is the same as it is on Windows. The configuration of 
ClearQuest Web requires additional steps. 
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Configuring the RCP Client on Linux and UNIX 

To configure e-mail notification in the RCP Client on Linux or UNIX, select “E-mail 
Options” from the “Tools” menu. Check the “Enable E-mail notification” box. The E-mail 
provider defaults to SMTP. Click “Next” to continue. 
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Configuring the RCP Client on Linux and UNIX 

Enter the host 
name or IP 
address of 
the SMTP 

server 

Enter your 
e-mail 

address 

At the next screen, provide the host name or IP address of the SMTP server you would 
like to use to send e-mails and the e-mail address that will be used. Click “Finish.” 
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Configuring ClearQuest Web on Linux and UNIX 

� 1. Identify the owner of the Request Manager 
process 

� 2. Create the necessary directories and files 

� 3. Modify the SendMail file 

� 4. Verify settings in Site Configuration 

The configuration of ClearQuest Web on Linux or UNIX consists of four basic steps: 
identifying who owns the Request Manager process, creating directories and files, 
modifying the SendMail file that holds the configuration settings, and verifying these 
settings in Site Configuration. 
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Configuring ClearQuest Web on Linux and UNIX 

� 1. Identify the owner of the Request Manager 
process 
�ps –ef | grep request 
�nobody 10272 17939 0 01:00 ? 00:00:34 

/opt/rational/common/IBMJava2-142/jre/bin/java -Xms64m -Xmx256m 
-cp config:requestmgr.jar:../:../lib/cqjni.jar:../lib/logging.jar: 

To identify which user owns the Request Manager process, run ps –ef and grep for 
“request”. This should return a process similar to the one shown on the slide. The 
important part is the first word, which in this case is “nobody”. This means that the user 
“nobody” owns the Request Manager process. You may have changed the configuration of 
ClearQuest so that the user is no longer “nobody,” and instead is “clearquest” or 
something similar. Write down that user name. 
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Configuring ClearQuest Web on Linux and UNIX 

� 2. Create the necessary directories and files 
�Identify the home directory of the user owning the 

Request Manager process 

�In the home directory of that user, run 
� mkdir –p .Rational/.Registry/ClearQuest 

� touch .Rational/.Registry/ClearQuest/SendMail 

� chmod –R u+rwx .Rational 

After you have determined which user owns the Request Manager process, you need to 
find out their home directory. 

• On a terminal, change to that user’s home directory and run mkdir –p
 
.Rational/.Registry/ClearQuest to create the required directory structure.
 

• Using the “touch” command, create a file called “SendMail”, making sure you type an 
uppercase S and an uppercase M. 

• Finally, you need to give the owner of the Request Manager process read, write and 
execute rights on the entire Directory Structure and the “SendMail” file. 
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Configuring ClearQuest Web on Linux and UNIX 

� 3. Modify the SendMail file 

SendActive: 1 
ReplyTo: clearquest@company.com 
SMTPHost: smtp.company.com 

.Rational/.Registry/ClearQuest/SendMail 

Open the “SendMail” file in an editor of your choice. You will need to add three lines in that 
file. It is important that you pay close attention to the spelling and punctuation or the 
settings will not work. 

The first line, “SendActive:” can be a 1 or a 0. 1 means that the e-mail notification is on, 0 
means that it’s off. 

The second line, “ReplyTo:” stores the e-mail address that ClearQuest Web will use as a 
sender of e-mail notifications. 

The third line, “SMTPHost:” is used to specify the host name or IP address of the SMTP 
server to be used for sending e-mail notifications. 

Save the file when you are done. 
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Configuring ClearQuest Web on Linux and UNIX 

� 4. Verify settings in Site Configuration 

To verify the settings in ClearQuest Web: 
• Log in to ClearQuest Web and click “Site Configuration” from the top navigation bar. 
• Switch to the “Email Options” tab to check if the settings you have made in the 

“SendMail” file are correctly represented here. 
• If so, this concludes the configuration steps for e-mail notification in ClearQuest 

Web on Linux or UNIX. 
• If the settings displayed are different, make sure you have properly set the
 

permissions in Step 2.
 
• If it still fails to display correctly, contact Rational Client Support for assistance. 
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Summary 

�Configuration for RCP and native client needs to 
be done for every user 

�Configuration for ClearQuest Web needs to be 
done once 

�MAPI only on Windows, SMTP is available across 
all platforms 

In summary, this module covered the basic concepts behind e-mail notification and how 
ClearQuest uses them. You should know how to configure e-mail notification on Windows 
and on Linux/UNIX platforms for the RCP client, the native client and ClearQuest Web. 
Remember that the configuration for the RCP and the native client needs to be done for 
every user individually, and that MAPI is only available on Windows. 
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Feedback 

Your feedback is valuable 
You can help improve the quality of IBM Education Assistant content to better 

meet your needs by providing feedback. 

� Did you find this module useful? 

� Did it help you solve a problem or answer a question? 

� Do you have suggestions for improvements? 

Click to send e-mail feedback: 

mailto:iea@us.ibm.com?subject=Feedback_about_RCQ_ClearQuest_EmailNotification.ppt 

This module is also available in PDF format at: ../RCQ_ClearQuest_EmailNotification.pdf 

Your feedback is valuable. 

Did you find this module useful? Did it help you solve a problem or answer a question? Do 
you have suggestions for improvements? You can help improve the quality of Rational 
content by providing feedback. Send an e-mail to the address shown here. 
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A current list of other IBM trademarks is available on the Web at http://www.ibm.com/legal/copytrade.shtml 

Rational is a trademark of International Business Machines Corporation and Rational Software Corporation in the United States, Other Countries, or both. 

Microsoft, Outlook, Windows, and the Windows logo are registered trademarks of Microsoft Corporation in the United States, other countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other countries. 

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. 

Product data has been reviewed for accuracy as of the date of initial publication. Product data is subject to change without notice. This document could include technical inaccuracies or 
typographical errors. IBM may make improvements or changes in the products or programs described herein at any time without notice. Any statements regarding IBM's future direction 
and intent are subject to change or withdrawal without notice, and represent goals and objectives only. References in this document to IBM products, programs, or services does not imply 
that IBM intends to make such products, programs or services available in all countries in which IBM operates or does business. Any reference to an IBM Program Product in this 
document is not intended to state or imply that only that program product may be used. Any functionally equivalent program, that does not infringe IBM's intellectual property rights, may 
be used instead. 

Information is provided "AS IS" without warranty of any kind. THE INFORMATION PROVIDED IN THIS DOCUMENT IS DISTRIBUTED "AS IS" WITHOUT ANY WARRANTY, EITHER 
EXPRESS OR IMPLIED. IBM EXPRESSLY DISCLAIMS ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT. IBM shall 
have no responsibility to update this information. IBM products are warranted, if at all, according to the terms and conditions of the agreements (for example, IBM Customer Agreement, 
Statement of Limited Warranty, International Program License Agreement, etc.) under which they are provided. Information concerning non-IBM products was obtained from the suppliers 
of those products, their published announcements or other publicly available sources. IBM has not tested those products in connection with this publication and cannot confirm the 
accuracy of performance, compatibility or any other claims related to non-IBM products. 

IBM makes no representations or warranties, express or implied, regarding non-IBM products and services. 

The provision of the information contained herein is not intended to, and does not, grant any right or license under any IBM patents or copyrights. Inquiries regarding patent or copyright 
licenses should be made, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment. All customer examples described are presented as illustrations of 
how those customers have used IBM products and the results they may have achieved. The actual throughput or performance that any user will experience will vary depending upon 
considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage configuration, and the workload processed. Therefore, no assurance 
can be given that an individual user will achieve throughput or performance improvements equivalent to the ratios stated here. 

© Copyright International Business Machines Corporation 2008. All rights reserved. 

Note to U.S. Government Users - Documentation related to restricted rights-Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract and IBM Corp. 
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